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Section 1

Specifications

1.1 Mechanical

SUNA with optional wiper Standard SUNA
Rated depth 100 m 500 m
Weight (in air) 3.1kg 2.5kg
Pathlength 10 mm 5 mm 10 mm 5 mm
Displacement 2092 cm3 2084 cm3 1749 cm? 1745 cm?
Length 588 mm 583 mm 567 mm 562 mm
Diameter 63 mm
Material Acetal
Temperature range, operation 0-35°C
Temperature range, dry storage -20-50 °C
1.1.1 Bulkhead connector
Contact Standard Optional (USB/SDI-12) MCBH-8-MP

1 Voltage in 8-18 VDC (15 VDC for sensors with wiper)

2 Ground

3 — USB 5 V power

4 — SDI-12

5 RS232 TX RS232 TX/USB D+

6 RS232 RX RS232 RX/USB D-

7 — Analog V out

8 — Analog current out

1.1.2 Dimensions

703mm
[27.7in]

567mm
[223in]

196mm 10mm

[7.7in] T [4in]

L8 PINBULKHEAD, BRASS

589mm

10 mm pathlength without wiper

[23.2in]
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Specifications

1.2 Electrical

Input

8-18 VDC

Input, sensor with wiper

8-15VDC

Current draw, operation

~625 mA at 12 V (nominal)

Current draw, supervised low power <30 A
(Periodic mode)

Current draw, processor low power < 3 mA polled
(Polled mode)

Current draw, standby ~20mAat12V

(SDI-12 mode)

Baud rate

57600 (9600, 19200, 38400, and 115200 available)

Communication interface

RS232 (USB and SDI-12 optional)

Data storage

2 GB (optional)

1.3 Optical

Spectral range

190-370 nm

Light source

UV deuterium lamp (900 hr lifetime)

1.4 Analytical

1.4.1 Nitrate measurement accuracy

Concentration
range

Seawater and fresh water calibrations, 10 mm

pathlength

Seawater and fresh water calibrations, 5 mm
pathlength

Sensor-specific

Class-based

Sensor-specific

Class-based

Best accuracy

2 UM (0.028 mgN/L)

2.5 uM (0.035 mgNI/L)

4 uM (0.056 mgNI/L)

4.5 uM (0.063 mgN/L)

up to 1000 yM 10% 20% 10% 20%
(14 mgN/L)
up to 2000 uM 15% 25% 15% 25%
(28 mgN/L)
up to 3000 uM 20% 30% 15% 25%
(42 mgN/L)
up to 4000 uM 25%

(0.056 mgN/L)

+ The specified accuracy is best accuracy or a percentage, whichever is more.
* A sensor-specific calibration uses extinction coefficients from the sensor itself.

+ Aclass-based calibration uses extinction coefficients that are the average of many
Sensors.
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1.4.2 Nitrate measurement precision

Processing configuration

Seawater or fresh water with T-S
correction

Seawater (0—40 psu)

Short-term precision (3 sigma) and limit of detection

0.3 uM (0.004 mgN/L)

2.4 uM (0.034 mgN/L)

Change ("drift") per hour of lamp time

< 0.3 uM (< 0.004 mgN/L)

< 1.0 pM (< 0.014 mgNI/L)

Limit of quantification

1.0 uM (0.014 mgN/L)

8.0 uM (0.112 mgN/L)




Section2 Operation

2.1 Install software

The Universal Coastal Interface (UCI) software communicates with a number of sensors.
Refer to the sea-birdcoastal.com website for the current list of sensors that use this

software.

1. Get the software from the sea-birdcoastal.com website or the manufacturer-supplied

CD.

2. Double-click on the file with ".exe" appended to the name.

3. Push Run in the new window.
The setup wizard starts.

4. Push Next.

« UCI 1.0.0 Setup

UCI

UNIVERSAL
COASTAL
INTERFACE

SEA-BIRD
COASTAL

=1clx|

Welcome to the UCI 1.0.0 Setup
Wizard

This wizard will guide you through the installation of UCI

It is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Mext to continue.

5. Push Agree in the next window to agree with the terms of the software.
6. Install the software at the default location or push Browse to go to another location to

install the software.
7. Push Next.

« UCI 1.0.0 Setup

Choose Install Location

— | =
Choose the folder in which to install UCI 1.0.0. 6

Setup will install UCI 1.0.0 in the following folder. To install in a different folder, click
Browse and select another folder. Click Next to continue.

sea-Bird-Coastal\UCE-1.0.0 Browse...

Space required: 175.2MB
Space available: 207.7GB

hullseft Install System v2.46

< Back Next > | Cancel |

8. Put a check in the boxes next to the "Install USB-Serial Driver and "Show Readme."

9. Push Finish.
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« UCI 1.0.0 Setup i3 o =1 3

Completing the UCI 1.0.0 Setup
Wizard

WARNING: Ensure SUNA is not connected to a USB port
when installing the Satlantic USB-Serial Driver.
The driver will fail to operate if is is installed while SUNA is

L‘NIVF RSAI connected.
{: ﬁ A g TA L [+ Install Satlantic USB-Serial Driver
I NT[ RrAC[ |7 Show Readme

SEA-BIRD
COASTAL

= Back Finish | Cance]

The software is ready to use.

2.2 Verify sensor operation

AWARNING

Nitrate sensors use an ultraviolet (UV) light. Do not look directly at a UV light when it is on. It can
damage the eyes. Keep products that have UV light away from children, pets, and other living
organisms. Wear polycarbonate UV-resistant safety glasses to protect the eyes when a UV light is
on.

ACAUTION

Do not supply more than 15 VDC to the sensor. More than 15 VDC will damage the wiper.

Do the steps below to make sure that the sensor operates before further setup and
deployment.

1.

No gk

Connect the connectors on the cable to the bulkhead connector on the sensor and to
the PC.

Connect the USB or RS232 cable to the PC.

For RS232: connect the power connectors on the cable to a 8-15 VDC power supply.
For USB: a DC power supply is only necessary for data collection. If the sensor is
equipped with internal memory, the file system will show as a USB mass storage
device on the PC.

If necessary, start the software.

RS232: turn on the power supply.

Push Connect in the UCI Dashboard area.

If necessary, change the "Sensor Type" to the connected sensor.

Put a check in the "Try All Baud Rates" box.
The software automatically finds the correct baud rate.

If necessary, select the communication port.
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| x|
[nstrumentType:ISUNA = Instrument Type: |HydroCAT ~

hal Baud Rate: 19200 =~

¥ Try All Baud Rates

Baud
7 I

Port:

Connect I Cancel | Help | Connect | Cancel Help |

9. Push Connect.
The "Connection Mode" shows "Transition" on a yellow background, and then shows

"Setup" on a green background.
Connection Mode:  Setup

10. Push SUNA Settings in the SUNA Dashboard area.
Make sure that the "Operational Mode" at the top of the new window is "Continuous."

SUNA Dashboard X

UCI Dashboard

Connection Mode:  Setup™

Connection Status: |Connected - COM3

Available Lamp Time: |998 hours (100%!)

Available Disk Space: |3,459 MB (92%)

SUNA Clock Time: |28 Jan 2015 10:53:33 UTC
SUNA Serial Number: 468 FW Rev: 2.3.2
{_B Disconnect d Transfer Files
SUNA Settings | @ Wipe Now

4 Reference Update

@ command Termi

C_) Start | Replay Logged Date

11. Push Start in the SUNA Dashboard area.
The sensor collects data that shows in the Spectra Graph and Time Series Graph

tabs.
12. For sensors that are not equipped with internal memory: Select the View menu, then
Data Logging. Push Start Log to save data to the PC.

13. Let the sensor collect data for a minute or two.
14. Push Stop.
15. Make sure that the collected data is saved.

»  Sensors with internal memory: select Transfer Files in the SUNA Dashboard.
Look at the files on the right for the file that was most recently saved.

»  Sensors without internal memory: Go to the directory on the PC to see the file
that was most recently saved.

2.3 Set up sensor for deployment

The sensor can be attached to a cage or pipe for deployment. Make sure that the sensor
is attached correctly or the sensor may be damaged. The manufacturer recommends that
the sensor operates in a horizontal orientation.
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SUNA optical area pointed sideways, and down, to reduce the collection of sediment and bio-fouling.

Do not use the wiper as a handle.
Do not attach the sensor to a cage or pipe at the wiper.

Do not attach the sensor so tightly that the sensor is out-of-round. Failure of the
pressure seals can occur.

Do not let the wiper touch any part of a cage or pipe.

Use cradle clamps to attach the sensor to a flat surface such as a cage.

Make sure that both ends of the sensor are attached to a cage or pipe. Do not leave
one end unattached, such as at the end of a pipe.

The user can attach the sensor to a cage with hose clamps:

a. Put several layers of electrical tape around the sensor to protect the pressure
housing.

b. Put clamps over the electrical tape.

2.4 Use software to set up sensor for deployment

The user can deploy the sensor in an autonomous or a logger-controlled mode.
Autonomous modes

Continuous operation—when started, the sensor operates until the user removes
power or pushes Stop in the SUNA Dashboard.

Fixed-time operation—the sensor operates for a user-specified period of time or
number of measurements.

Periodic operation—the sensor operates at user-specified intervals. Data collection
begins at a user-specified date and time and stops when the user removes power or
pushes Stop in the SUNA Dashboard.

Example: a sensor set up at 8:00 with a "Sample Interval" of 2 hours and an offset of
900 seconds (15 minutes) will operate at 10:15, 12:15, 2:15, etc.

Logger-controlled modes

Polled operation—the sensor communicates through and is controlled by an
RS232 terminal program.
SDI-12—The sensor communicates through and is controlled by an SDI-12 controller.

2.4.1 Set up for autonomous deployment

1.

@

Make sure that the sensor is connected to a power supply and PC (RS232 or USB
cable) and is on.

Make sure that the software is open and in communication with the sensor.
Push SUNA Settings in the SUNA Dashboard area.
Select the "Operational Mode" for the planned deployment.

10
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5. Use the manufacturer-set values for that operation mode or change them as
necessary.

| & SUNA Settings

General | Telemetry | Advanced |

Operational Mode: IContinuous 'l

Continuous Operation

Periodic
¥ Frame Based OfFixed Time
Polled
Frame Cycle: |1
o SDriz
APEX Float

1000

6. If the sensor has an integrated wiper, put a check in the "Integrated Wiper Enabled”
box.

¥ Integrated Wiper Enabled

[Wiper Settings

The wiper operates one time data is collected, but no more than once per hour.

7. If the sensor is to be deployed in fresh water but has a calibration for seawater, select
the Advanced tab and put a check in the "Deployed in Fresh Water" box.

Salt Water Calibration———
¥ Deployed in Fresh Water

[” Bromide Trace

8. Push Upload to save the settings in the sensor.

9. Push OK to save any changes, or push Cancel to close the window with no changes.
10. Go to the UCI menu at the top of the software window and select Exit (Ctrl-e).

11. Exit the software:

* Push No to close the software.
Turn off the sensor, remove from the power supply and attach the protective
dummy connector and lock collar.

» Push Yes to close the software and start the sensor. The sensor will collect data
immediately if the user selected "Continuous" or "Fixed-time" or at the user-
specified time if "Periodic" was selected.

Main Power Connected

2.4.2 Set up for SDI-12 deployment
The user can deploy the sensor in a logger-controlled mode with an SDI-12 controller.

Set up the sensor in SDI-12 mode to operate with a controller.

Make sure that the sensor is connected to and in communication with the software.
Push SUNA Settings in the SUNA Dashboard.

At the General tab, select the "SDI 12 Operational Mode."

oo bd=

11
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General | Telemetry | Advanced |

Operational Mode: SDI12 'I

- Sample Averaging

Number of Measurements to Average: |1E|

 Deployment Characteristic

Estimated Frame Rate: |0.1653 frames/sec

Wiper Setting
™ Integrated Wiper Enabled ‘

" SUNA M

Logging Level: INFO 'l
Maximum Log File Size: 2 32 MB

Upload | Cancel I Default | Help |

5. If necessary, change the "Number of Measurements per Frame."
The sensor calculates the average of the value entered. For example, if "5" is
entered, 5 measurements will be averaged and will show as one measurement in the
data.

6. If the sensor is so equipped, put a check in the "Integrated Wiper Enabled" box.
The wiper operates before each measurement.

7. The default "Logging Level" is INFO.

8. Push Upload.

Exit Command Mode o x|

i Exit Command mode? Click yes to put the SUNA
~  into SDI 12 mode.The serial connection wil
then be dosed.

Clicking no wil require the power to the SUNA
to be recycled to put it in SDI 12 mode.

1w |

A new window shows.

9. Push Yes to put the SUNA into SDI-12 mode.
The sensor is ready to connect to an SDI-12 data logger.

2.5 Monitor data collection

Use the software to monitor data as it is collected, or to look at it after a deployment, if the
sensor is equipped with internal memory. If the sensor does not have internal memory,
make sure to use the Data Logging tab to save collected data to a PC.

1. Push Start in the SUNA Dashboard area.
2. From the View menu, select the options to see the data:

* Real Time Data—shows the most current data from the selected sensors.

12
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Real Time Display: SUNA0166 X | =| e e
=
Select Sensors _l
Name Value Units " = _I
Nitrate UM I~ Humidity
ABS_254 a.u. [~ Voltage
ABS_350 a.u.
[ Internal Temperatu...
. ¥ Absorbance at 254nm
1¥] Acquisition Information
[¥ Absorbance at 350nm
I Bromide Trace
4 | | oK | Cancel I Help |
» Data Logging—Push Start Log to save the collected data to the PC.
i Data Logging: SUNAD166 X |
Frames Logged:l 0 Log Timer: () Start Log
¥/ Logging Options
.

Push Select Sensors to see a list of
tab.

Time Series graph.

Configure Sensor Se :5

™ Humidity

I~ voltage

I~ Internal Temperaty..,
au [ Absorbance at 254nm
¥ Absorbance at 350nm
™ Bromide Trace

| Cancel I

am, oK Help

Time Series, Spectra, and Total Absorbance graphs.

parameters that can show in the Time Series

Put a check in the box next to any additional parameters so that they will show in the

Time Series

x|

CELSIUS

5. Look at the data in the Time Series tab.

Spectra: SUNAD166 = Time Series: SUNA0166 x| Tofal Absorbance: SUNAO16E6 = Jrli=lal
(+) Zoom In | (=1, Zoom Out | Auto Range | [# Time Axis [~ Range Axis Select Sensors | Configura
Time Series

50
25
= MW
-2.8
0.025 e e ————— — — -
0.020 -
0015
5
® oo10
0.005
0.000
0.08
0.05
0.04
= 003
0.02
0.01
0.00
22:18:45 22:18:50 2211855 22:19:00 22:19:05 22:18:10 221916 22:19:20 2211825 22:18:30  22:18:35 2211040 22:18:45
Time (UTC)
[ ritrate — aBS_254 — Ams_aso

change the scale of time.

change the scale of the data.

Put a check in the box next to "Time Axis" to push Zoom In and Zoom Out to

Put a check in the box next to "Range Axis" to push Zoom In and Zoom Out to

13
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To move the data in any direction, push the "Ctrl" key on the PC keyboard and
the left button of the mouse pointer at the same time.

To select a specific part of the data to zoom in on, pull the mouse pointer
diagonally (refer to the arrow in the graph below).

25

0.0

i

25

-5.0

D015
S poio
m
0005
0000

0.04

. 0o3
=]

LT

Time Series

2.5.1 Monitor data in spectra graph
The Spectra graph shows both the dark and light data in raw counts.
The dark counts are from thermal noise. The light counts are the measured output minus
the dark counts.
The measured spectrum is always flat below 200 nm, and then has four or five peaks.
The peaks are approximately 25 nm apart in the lower wavelength range and up to 50 nm
apart in the upper range.

Spectra: SUNAO166 x| Time Series: SUNAO166 x| Total Absorb:

SUNAO166 x > =liaf

\zoomout | AutoRange | ¥ Wavelength Axis I Range Axis Configure

G zoommn |

Spectra

45000

0000

_J

uuuuu

Dark Data Range

5 00
Wavelenath (nm)

3.

Put a check in the box next to either or both the "Wavelength Axis" or the "Range
Axis" to enable the Zoom In or Zoom Out options.
The user can change the values for the axis with a check in the box.

Push Select Sensors either in the Time Series graph or in the Real Time Display tab
to select the parameters to see on the graph.

Push Configure to put a limit on or to remove the limit to the "Time Axis Range."

2.5.2 Monitor data in time series graph

The Time Series graph shows the nitrate concentration and any selected optional values.
Use this graph to replay data that is stored in the sensor.

14
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Spectra: SUNAD166 = Time Series: SUNADLG6 x| Total Absorbance: SUNAQ166 = dri=lEl
(%) Zoom In | (=}, Zoom Out Auto Range | [¥ Time Axis [~ Range Axis Select Sensors | Configure
Time Series

50
25
= oo /\/\/\_/‘_"\/\_/\,_/\\‘/-\/\_/

0.025
0.020

0.015
=

® o010

0.005

0.000
0.08
0085
004

= 003
002

001

0.00
22:18:45 2200850 2201855 22018:00 22018:05 221910 22019015 22018:20  22:9:25  22:19:30 22019035 22018040 22:10:45
Time (UTC)

[ ritrate — aBS_254 — ABS_aso

1. Put a check in the box next to either or both the "Time Axis" or the "Range Axis" to
enable the Zoom In or Zoom Out options.

2. Push Select Sensors either in the Spectra graph or in the Real Time Display tab to
select the parameters to see on the graph.

3. Push Configure to put a limit on or to remove the limit to the "Graph History."

2.5.3 Monitor data in absorbance graph

The Total Absorbance graph shows the calculated absorbance from 210 to 370 nm. This
graph is an alternative to the Spectra graph. The absorbance graph should be flat when a
sample of DI water is collected. The absorbance increases as absorbing species such as
nitrate and bromide are added to samples.

Spectra: SUNA0166 x| Time Series: SUNAO166 x| Total Absorbance: SUNAO166 x| R =
Configure
Total Absorbance
I
/ N\
0045 / M
0040 \
0035 MW
o030
= oo T
Ed /
0010 /
05 y
oo |/
uuuuu
20150211 142008
o010
20 250 o 0 an = 0 ED) a
Wavelzngth (nm)
0 0 2 an an sn )

2.6 Get data from sensor

ACAUTION

Do data transfers away from harsh environments such as strong electric fields or electrostatic
discharge sources. Electrostatic Discharge (ESD) sources may temporarily disrupt data transfer. If
this occurs, move the sensor away from the ESD source. Turn the power off and then on and
continue operation.

If the sensor is equipped with internal memory, the collected data is saved in the sensor.

1. Push Transfer Files in the SUNA Dashboard area.
The files saved on the sensor show on the right side of the new File Manager
window.

15



Operation

File Mana X
Data F"ESl Log Files| Calibration Files
Local Y rInstrument y:
[c:\suna Browse | Name Date + Size Type |
C0000295.C5V 20140822 16:06:22 1046705  CSV =
Name Date - [ size [1y...| CO00D300.CSV  2014-08-22 16:19:32 1046607  CSV
SUNA-0468_2015-01-28_05-47-45_raw... 2015-01-28 13:47... 10938 CSV C0000301.CSV  2014-08-22 4 1046576 CSV
SUNA-0468_2015-01-28_05-52-22_raw... 2015-01-28 13:53... 78819 CSV C0000302.CSV  2014-08-22 6 1046603 SV
SUNA-0468_2015-01-28_11-17-05_raw... 2015-01-28 19:20... 2417... CSV C0000303.CSV  2014-08-22 8 1046640 SV
SUNA-0468_2015-01-28_13-32-28_raw... 2015-01-28 21:32... 33528 CSV C0000304.CSV 2014-08-22 0 1046634 CSV
SUNA-0468_2015-01-28_13-35-14_raw... 2015-01-28 21:35... 31193 CSV C0000305.CSV 2014-11-18 2 1046725 SV
SUNA-0468_2015-01-28_13-35-44_raw... 2015-01-28 21:36... 38331 CSV C0000312.CSV  2015-01-26 6 1047674  CSV
SUNA-0468_2015-01-28_13-36-14_raw... 2015-01-28 21:36... 39553 CSV C0000313.C5V  2015-01-26 0 1047264  CSV
SUNA-0468_2015-01-28_13-36-44_raw... 2015-01-28 21:37... 38357 CSV C0000314.CSV  2015-01-26 4 1047290 CSV
SUNA-0468_2015-01-28_13-37-14_raw... csv C0000315.C5V  2015-01-26 0 1047030 Csv
SUNA-0468_2015-01-28_13-37-44_raw... csv C0000316.CSV 2015-01-27 6 1047602 csv
C0000320.C5V 2015-02-10 21:31... 88722 CSV C0000317.CSV 2015-01-28 4 104689  CSV
C0000318.CSV 2015-01-28 8 1047200  csv
C0000310.C5V  2015-02-08 8 1047018 CSV
83722 zl
SelectAll | Delete Refresh SelectAl | Delete |

Abort

2. Select one or more files to copy to the PC.

The manufacturer recommends that the user use a USB connection to move the files

because it is much faster.

3. Push the <- arrow to start the move.
The status shows at the bottom of the File Manager window.

4. Open the file on the PC to make sure it has all of the collected data.

Help
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Section 3 Maintenance

3.1 Sensor maintenance

Although the sensor is built for deployment in severe conditions, it is important to clean
the sensor before each deployment and weekly (if deployed frequently) or monthly to
prevent fouling.

After every deployment:

1. Attach a clean and lubricated dummy plug and a lock collar to the sensor.
2. Rinse the sensor with fresh clean water.

3. Flush the optical area with fresh clean water.

4. Dry the sensor.

Use a soft towel or blow with air.
5. Put the sensor in the manufacturer-supplied case for transport or storage.

3.2 Maintenance for bulkhead connectors and cables

AWARNING

If the user thinks that a sensor has water in the pressure housing: Put on safety glasses and make
sure that the sensor is pointed away from the body. Use the purge port (if the sensor is so
equipped), or very SLOWLY loosen a bulkhead connector to allow the pressure to escape.

NOTICE

Connectors that have corrosion can cause a loss of data and increase the costs for service.

»  Connectors that have corrosion can cause irreparable damage to the sensor.
* Do not use cleaners that contain petroleum or ketones.

. Do not use the cable to lift the sensor. The cable, cable splices, and bulkhead connectors can
be damaged.

»  Attach cleaned and lubricated dummy connectors to the sensor immediately after each
deployment to prevent the bulkhead connector from damage

* Do not connect or disconnect connectors under water.

Examine, clean, and lubricate bulkhead connectors each time they are connected.
Connectors that are not lubricated cause wear and tear on the rubber that seals the
connector contacts.

1. Clean the connector contacts with isopropyl alcohol. Apply as a spray or with a nylon
brush or lint-free swabs or wipes.

2. Flush the contacts with de-ionized or distilled water. Use a wash bottle with a nozzle
to flush inside the sockets.

3. Shake the socket ends and wipe the pins of the connectors to remove water.
4. Examine the sockets and the rubber on the pins to make sure there are no problems.

a. Use a flashlight and magnifying glass.

b. Look for cracks, frayed scores, and delamination of the rubber on the pins and
inside the sockets.
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Table 1 Examples of damaged connectors

Corroded connector Damaged contact Damaged socket face

5. Use a finger to place a small quantity, approximately 1.5 cm in diameter of Dow
Corning® 4 Electrical Insulating Compound on the socket end of the connector.

Table 2 Lubricant on connector sockets

Lubricant on socket end of the connector Lubricant pushed into the sockets of the connector

6. Use a finger to push as much of the lubricant as possible into the sockets.

7. Connect the connectors.
There should be a small quantity of lubricant pushed to the sides of the connectors.

8. Clean the unwanted lubricant from the sides of the connectors.
The connectors are now lubricated and the connection is waterproof.

3.3 Update reference spectrum

The user needs to update the reference spectrum of the SUNA at regular intervals so that
the data that the sensor collects is accurate. It may also be necessary to update the
firmware, although that is not required very frequently.

A calibration file contains the data required to convert a spectral measurement into a
nitrate concentration. The calibration data are the wavelengths of the spectrum, the
extinction coefficients of chemical species and a reference spectrum relative to which the
measurement is interpreted. The sensor can store many calibration files, but only the
active file has a green background. Push Transfer Files > File Manager, then select the
Calibration Files tab to see the list of calibration files stored in the sensor.

Make sure to clean the sensor and the sensor windows at regular intervals and before
and after every deployment. Monitor the spectral intensity of the lamp. Although the
intensity will decrease over time, make sure there are no sudden changes.
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Necessary supplies:

Power supply

PC with software

Connector cable for sensor—PC—power supply
Clean de-ionized (DI) water

Lint-free tissues

Cotton swabs

Isopropyl alcohol (IPA)

Parafilm® wrap

Notes

2,

Use only lint-free tissues, OPTO-WIPES™, or cotton swabs to clean the optical
windows.

Use the software to update the reference spectrum.

Use only clean DI water that has been stored in clean glassware.

Use Parafilm® wrap to capture DI water in the optical area of the sensor. Do not use
cups, a bucket, or a tank to collect a reference sample.

Clean the sensor:

a. Flush the sensor and the optical area with clean water to remove debris and
saltwater.

b. Clean the metal parts external to the optical area so that the Parafilm® will seal.
If the sensor has a wiper, carefully move it away from the optical area.

Figure 1 Wiper moved from optical area

3. Cut and stretch a length of approximately 40 cm (16 in.) of Parafim®,
4. Wind the Parafilm® around the metal near the optical area.

Figure 2 Parafilm® on optical area
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5.

Break a small hole in the top of the Parafilm® and fill the optical area with DI water.

Figure 3 Optical area filled with DI water

10.
1.

12,
13.
14,

15.

16.
17.

18.
19.
20.
21.
22,

23.

24,
25.
26.

Supply power to the sensor and use the software to operate the sensor in
"Continuous" mode.

Start the sensor and collect 1 minute of data.

Record the measurement value.
This is a "dirty" measurement to record the value when there are biofouling and
blockages in the optical area.

Stop the sensor.
Remove the Parafiim® and drain the water from the optical area.
Clean the optical area:

a. Use DI water or IPA and cotton swabs and lint-free tissues to clean the windows.

b. Use vinegar to clean debris such as barnacles. Be careful that the windows do
not get scratches.

Flush the optical area with DI water to remove any remaining IPA or vinegar.
Wind Parafilm® around the metal near the optical area.

Break a small hole in the top of the Parafilm® and fill the optical area with fresh DI
water.

Supply power to the sensor and use the software to operate the sensor in
"Continuous" mode.

Start the sensor and collect 1 minute of data.

Record the measurement value.
This measurement shows any sensor "drift" or change in the lamp output.

Stop the sensor.

Remove the Parafiim® and drain the water from the optical area.
Flush the optical area with DI water.

Wind Parafilm® around the metal near the optical area.

Break a small hole in the top of the Parafilm® and fill the optical area with fresh DI
water.

Supply power to the sensor and use the software to operate the sensor in
"Continuous" mode.

Start the sensor and collect 1 minute of data.
Record the measurement value.
Use the software to update the reference spectrum.

a. Go to the Sensor menu, then select Update Calibration.
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b. Do the steps in the Calibration Wizard to update the reference spectrum.

27. If the measurement is +2 uM (0.028 mgN/L) from the manufacturer-supplied

reference (5 uM [0.056 mgN/L] for a 5 mm pathlength sensor), the sensor is within
the specification.

If the measurement is not within these specifications, do this procedure from step

9 until the measurement is within specification.

3.4 Update firmware

At regular intervals, make sure that the current firmware is installed in the SUNA. Go to
the seabird-coastal.com web site to get the current firmware for the sensor.

1.

Save the firmware to the PC.
The firmware is an ".sfw" file.

Make sure that the sensor is connected to the PC and a power supply.
Push Connect.

Go to the Sensor menu, then select SUNA, then Advanced, then Upload Firmware
File.

UCI UCI 1.0.0_151

UCT | Sensor Data View Window Help

{T> Connect |
O sart
OCAT »
Y AIOCATY SUNA Settings
Connection Mode:
|/ Transfer Files
. Reference Update | — |
Connection Status:
(© set dock I
Available Lamp Tim |
&7 wipe now —
Available Disk Spac |
Summary Report
SUNA Clock Time: g8 command Terminal

SuA serel b SETS N  Ecit Log Headers

_ SUNA Self Test
I {E Disconnact | Transfer _ DAC Calibration
e Upload Frmware Fie

| SUNA Settings | @ Wipe i Administrative Settings
] " Upload Instrument XML Fie
L e - .

Push Browse to find the firmware file that is saved on the PC.
Push Open.

Push Upload.
It takes approximately 2 minutes for the software to complete the upload.
Boot Loader VCP Driver Install x|

The SUNA Boot Loader's Virtual COM Port driver may not have been previously installed.

" If this is the case the driver wil be instaled automatically.

After the driver has been installed press the OK button to proceed.

The firmware is updated.
The software disconnects the sensor.
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Section4 Reference

4.1 Software settings

This section has information about configuration values and modes of operation that
apply to all deployments.

4.1.1 Communication

Go to the Telemetry tab in SUNA Settings to set up communication and data file types.

& SUNA Settings i x|
General Telemetry | Advanced |

Data Transmission

Serial Baud Rate: 57600 hd
Transmitted Frame Format: FULL_ASCH &

Data Logging

Instrument Logging Frame Format: IFULL_ASCH hd

Log File Creation Method: IBy File Size b
Maximum Size: |1 33 MB

Upload | Cancel I Default | Help |

The default serial baud rate is 57600. Others are available.
Data Transmission

Serial Baud Rate: 57600 ~|
Transmitted Frame Format: 19200
38400
Data Logging 57600
115200

The default for "Transmitted Frame Format" and "Instrument Logging Frame Format" is
"FULL_ASCIL"

Transmitted Frame Format: | FULL_ASCII ~]

Data Logging

Instrument Logging Frame Format: |FULL_ASCII ﬂ

NONE

Log File Creation Method:

Maximum Size: |1 3: MB FULL_BINARY
REDUCED_BINARY
CONCENTRATION
APF

FULL_ASCII—Contains all collected data in comma-separated fields. The file

extension is .csv. The frame size is typically 1600-1800 bytes. Use this format so
that data can be reprocessed.

NONE—For "Transmitted Frame Format" data output is turned off. For "Sensor
Logging Frame Format" sensor data storage is turned off.

Other available formats:
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*  FULL_BINARY—Contains all collected data. The file extension is .bin. The frame
size is 632 bytes. Use this format so that data can be reprocessed.

+ REDUCED_BINARY—Contains data from part of the spectrum and data from some
auxiliary sensors. The file extension is .bin.The frame size is 144 bytes. Use this
format so that seawater data can be reprocessed.

+ CONCENTRATION ASCIlI—Contains a time-stamp, nitrate concentration,
absorbance at 254 and 300 nm and Root Mean Square Error (RMSE) to measure the
quality of the data. The file extension is .csv.

* APF—Used for APEX floats. Contains the user-selected parts of the spectrum and
other auxiliary sensors. The frame size is typically 300-400 bytes.

* The user can set the "Transmitted Frame Format" to "NONE" to turn off data output.
This increases the rate at which data is collected, and uses 10—-30% less power.

* The user can set the "Instrument Logging Frame Format" to NONE to turn off internal
data collection.

The default "Log File Creation Method" is "By File Size." Others are available.
Data Logging

Instrument Logging Frame Format: IFULL_ASC]I LI
Log File Creation Method: By File Size ll
Maximum Size: |1 3: MB By Sample Event

» By File Size—The software makes a new file when the data file in use gets to the
user-selected maximum size. The file name starts with "C" ("Continuous" file).

+ By Sample Event—The software makes a new file when data collection starts for the
first time after the power has been turned off, then on. The manufacturer
recommends that the user select this for testing only. Use of this setting can result in
so many stored files that the sensor operates slowly or incorrectly. The file name
starts with "A" ("Acquisition" file). Daily—All data that is collected during a calendar
day is putinto a single file. This file name is a seven-digit number that is the year and
the day of the year, for example, D2015142.csv. The file name starts with "D" ("Date-
stamped" file).

The default "Maximum File Size" is 2 MB when the "Mode of Operation" is set to
"Continuous." It is user-selected from 1-65 MB. The "Daily" and "Sample Event" files
contain all of the data that is collected during the day or during one cycle of operation.

4111 File types
The sensor uses three types of files:
» Data—either ASCII (.csv), or binary (.bin).
+ Calibration—reference spectrum updates from the manufacturer (.cal).
* Log—information about the sensor (.log)

Table 3 Information in data files
Column Data type Full ASCII Full Binary

1 Date, yyyy-mm-dd

2 Header and serial number N/A

3 Date, year and day-of-year Al7 BS 4

4 Time, hours of day AF BD 8
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Table 3 Information in data files (continued)

5 Nitrate concentration, yM AF BF 4
6 Nitrogen in nitrate, mgN/L AF BF 4
7 Absorbance, 254 nm AF BF 4
8 Absorbance, 350 nm AF BF 4
9 Bromide trace, mg/L AF BF 4
10 Spectrum average Al BU 2
11 Dark value used for fit Al BU 2
12 Integration time factor Al BU 1
13-268 Spectrum channels 256 x Al 256 x BU 2
269 Internal temperature, °C AF BF 4
270 Spectrometer temperature, °C AF BF 4
271 Lamp temperature, °C AF BF 4
272 Cumulative lamp on-time, secs Al BU 4
273 Relative humidity, % AF BF 4
274 Main voltage, V AF BF 4
275 Lamp voltage, V AF BF 4
276 Internal voltage, V AF BF 4
277 Main current, mA AF BF 4
278 Fit aux 1 AF BF 4
279 Fit aux 2 AF BF 4
280 Fit base 1 AF BF 4
281 Fit base 2 AF BF 4
282 Fit RMSE AF BF 4
283 if CTD: Time, secs Al BU 4
284 if CTD: Salinity, PSU AF BF 4
285 if CTD: Temperature, °C AF BF 4
286 if CTD: Pressure, dBar AF BF 4
287 Check sum Al BU 1
Terminator <CR><LF> —
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4.1.2 Continuous and fixed-time operation

SUNA Settings x| SUNA Settings x|
General Te\emetry' Advanced' General Telemetry' Advanced'
Operational Mode: Operational Mode: -
- Continuous Operational Mode Settings r Fixed Time Mode Setting
i Frame Based Operation ¢ Time Based Operation Fixed Acquisition Time: |60 SeC
Frame Cycle: |20 light frames & Frame Based Operation ~ Time Based Operation

10 dark frames Frame Cycle: IZU light frames
IlU dark frames

- Sample Averaging

~Sample Averaging

Number of Measurements to Average: Ill]
Number of Measurements to Average: |10

~ Deployment Characteristics

-~ Deployment Characteristics
Estimated Frame Rate: IU.1653 frames/sec

Estimated Frame Rate: |0.1653 frames/sec

Wiper Setting
™ Integrated Wiper Enabled ‘

Wiper Setting:
’V ™ Integrated Wiper Enabled ‘

SUNA Message:

Logging Level: INFO 'I T SUNA T
Logging Level: INFO hd
Maximum Log File Size: 2 EC MB

Maximum Log File Size: 2 33 MB

Upload | Cancel I Default Help

Upload | Cancel I Default | Help |

The sensor must regularly collect a dark spectrum measurement so that it has a baseline
correction for changes in time or "drift" in the output of the spectrometer.

The user can set up the sensor to collect a dark spectrum measurement on a time-based
or measurement-based schedule. A typical setup is a 1-second dark spectrum
measurement for each 20—-30 seconds (20—30 measurements) of the light spectrum.
4.1.3 Periodic operation
Use the software to see and change the settings for this mode of operation.
SUNA Settings x|

General | Telemetry | Advanced |

Operational Mode: 7

" Periodic Mode Setting

Sample Interval: |1 hr -

Offset: |0 sec

i Frame based operation ¢~ Time based operation

Light Frames: |3 frames

~Sample Averaging

Number of Measurements to Average: IlD

~Deployment Characteristics

Estimated Frame Rate: |n.1553 frames/sec

Wiper Settings
[~ Integrated Wiper Enabled ‘

SUNA I

Logging Level: MFO 'I
Maximum Log File Size: 2 35 MEB

Upload | Cancel I Default Help
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1. Select a "Sample Interval" from the drop-down menu.

Look at the "Offset" value. An offset value of 300 (5 min) changes the start time by
five minutes, for example, from 06:00 to 06:05.

3. The "Light Frames" value is 0-255.

Data is collected for either a user-selected quantity of time or a user-selected number of
measurements.

Note: "Periodic" and "Autonomous" are both terms for the same mode of operation.

4.1.4 Polled operation

Use the software to see and change the settings for this mode of operation.

SUNA Settings x|
General | Telemetry| Advanced|
Operational Mode: 7

 Sample Averaging

Number of Measurements to Average: |10

- Deployment Characteristics

Estimated Frame Rate: |0.1653 frames/sec

Wiper Setting
™ Integrated Wiper Enabled ‘

T SUNAT

Logging Level: IINFO v
Maximum Log File Size: |2 31 MB

Upload | Cancel I Default | Help |

Use the commands below to communicate with the sensor in RS232.

Command Result

Start Start continuous data collection.

$ Stops the sensor data collection.

Measure N | The sensor gets "n" light data frames. If "n" is zero, the sensor gets one dark data frame.

Timed N The sensor gets light data frames for "n" seconds.

CTD The sensor sends CTD data to be corrected for temperature and salinity. The sensor must be set up to do the
correction and to process it.

Status Print the status of the sensor.

Sleep The sensor goes to low power standby mode.

Data files are saved in "FULL_ASCII."
Note: "Polled" and "Logger-controlled" are both terms for the same mode of operation.
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4.1.5 Other general settings

Sample Averaging

Number of Measurements to Average: |10

Deployment Characteristics

Estimated Frame Rate: |0.1653 frames/sec
Wiper Settings

[ Integrated Wiper Enabled

SUNA Messages

Logging Level: INFO ‘I
Maximum Log File Size: 2 33 MB

Sample Averaging, Deployment Characteristics—The average of the number of frames
selected. The higher the value, the more time it takes to make a measurement. The
"Estimated Frame Rate" is directly related to the "Number of Measurements per Frame."
The manufacturer recommends a value of 10-15 as the "Number of Measurements per
Frame" to increase precision in a stable water sample. Use a lower value for unstable
water samples.

Wiper Settings—If the sensor is equipped with a wiper, the user can put a check in this
box so that the wiper will operate before each measurement.

SUNA Messages—The sensor gives information about the sensor operation and
collected data. The default is "Info."

»  "Error" gives the least information.
+ "Debug" and "Trace" give the most information and are used only for troubleshooting.

Set the "Maximum Log File Size" to "0" to turn off the messages.
Options to monitor data

The user can select additional parameters to look at from the Real Time Display tab in the
main window of the software. Push Select Sensors and put a check in the box next to
the parameter to measure.

Real Time Display: SUNAD166 X| = EETEE (S
r
Select Sensors |
i Configure Sensor Setl x|
Name Value Units o
Nitrate pM
ABS_254 a.Ll. [ Voltage
ABS_350 a.u.

[” Internal Temperatu...
¥ Absorbance at 254nm
¥ Absorbance at 350nm

[¥| Acquisition Information

[~ Bromide Trace

4| | 0K | Cancell Help |

4.1.6 Compare reference spectrum files

Compare the change between two reference spectrum files. The amount of change is
related to the time interval between the updates and the amount of lamp use during that
time.

Note that this procedure is done automatically by the software when the user updates the
reference spectrum for the sensor. Refer to Update reference spectrum on page 18 for
more information.

1. Find the two files to compare:
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File Manager
Data Files| Log Files Calibration Files
Local Filesy: ~Instrument Filesy
[c:\asBCUserManuals\SUNA Browse
SNAD166A.CAL 54
[ iz o SHAO1668.CAL 2012-11-13 16:11:00 15616 CAL —
2015-03-02 19:58:46 SNADL66C.CAL 2013-01-07 20:31:16 15616 CAL
2015-03-02 19:46:47 5830 CA SNAD166D.CAL 2013-01-14 18:53:20 15488 CAL
SNAD166E.CAL 2013-01-18 19:54:02 15360 CcAL
SNAD166F.CAL 2013-01-18 19:56:46 15616 CAL
SAD166G.CAL 2013-08-09 11:21:26 15744 CAL
SNAD166H.CAL 2013-08-20 19:40:28 15744 CAL
> SNAD1661.CAL 2014-11-13 16:56:36 15872 CAL
SHAD1661.CAL 2014-11-13 17:53:36 15872 CcAL
SNAD166K.CAL 2015-01-13 18:51:48 13952 CAL
< SHAD166L.CAL 2015-02-23 18:57:30 15616 CAL
SNAD166M. CAL 2015-02-23 19:08:56 15616 CcAL
SNAD166N.CAL 2015-02-23 19:43:36 15744 CAL
SHAD1660.CAL 2015-02-23 20:26:52 15744 CAL -
.CAL 2015-03-02 19:46:58 15872 AL hd
Select All | |i Delete Refresh Select All Delete Set Active

Push Transfer Files in the SUNA Dashboard area.

Select the Calibration Files tab.

Select the first file under Instrument filesystem.

Select the directory in the Local filesystem to save the file in.
Push the <-- to move the first file.

Do steps d and e to move the second file.

Push Close.

a.
b.
c.
d.
e.
f.

g.

Note that the date of the files changes to the current date.
2. Select the Data > SUNA > Compare Calibration menu
Push Browse to find to the first reference, or calibration, file on the PC to compare.

4. Push Browse to find to the second reference, or calibration, file on the PC to
compare.

5. Push Compare.

ol

Compare Calibration Files x|
Select First Calibration File:
|C:\aSBCUserManua\s\SuNA\SNAGlﬁﬁA.CAL Browse
Select Second Calibration File:
IC:\aSBCUserManua\s\SUNA\SNAUl&&P.ca\ Browse

ICaI\bration instrument serial numbers match.

Percent Change in Reference Spectra
20 B
a
- =]
-5 8
s
g 10
W
E s
g
=
.10
200 225 250 275 300 325 330
wavelength (nm)
B % difference

Compare I Close | Help |

A typical update interval of 3—6 months with no more than 100 hours of lamp use
should cause a change of no more than 10% in the 215-240 nm interval.

Below 215 nm, larger relative changes are normal.
Above 240 nm, the change is smaller than at the 215-240 nm range.

If there is a large change, do several reference updates 12—24 hours apart to monitor
the stability of the reference spectrum.

4.1.7 Data acquisition monitor

The software monitors the data collected by the sensor and shows any errors in this
window. The error counters are reset each time the sensor starts a new data collection
file. All information is transmitted during data collection, in real-time.

To see this tab, go to the View menu and select Acquisition Monitor.
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4.1.8 Files necessary to process data

41.8.1

Data Acqguisition Monitor X

Data Logging: SUNAD166

~Frame Statistics

Frame Id

Read

Errors

CheckSum Err...

Counter Errors

Status Errors

Fitting Errors

SATSDF0166

SATSDCO0166

SATSLCO166

SATSLFO166

~l

SATSDRO166

SATSLBO166

SATSDBO166

SATSLR0O166

[=1E==1E=2-=10==1

ololoolooolo

ololooloololo

ololooloololo

ololooloololo

olojlooloololo

Go to the Data menu to select how data is processed. The HydroCAT can only replay

Frame Id—the unique frame number.
Read—The number of frames accepted.
Errors—The number of frames discarded.

Checksum Errors—There may be a problem with the data that is transmitted.
Examine the cabling and connectors. If the value in such is frame is wrong, it is
discarded. If the collected data is saved to the internal memory of the sensor, that

data is correct and can be copied to the PC at a later time.
Counter, Status, and Fitting Errors—always zero.

data.

Use Convert Raw Data to change binary files into ASCII files.

Use Replay Logged Data to show a graph of saved data.
Use Reprocess Data to apply a different reference value or change the settings to

process the data.

The SUNA uses the three files below to process data:

1.

Convert raw data

The .xml package file that is stored in C:\users\%username%\AppData\Roaming\Sea-

Bird-Coasta\UCI 1.00\SUNA_%SN%.xml.
2. The raw data file to process.
3. The reference spectrum file (optional for Replay Logged Data).

Use the Convert Raw Data option to change binary data to ASCII.

1.

3. Put a check in the boxes next to the parameters to convert from binary to ASCII.

Go to the Data menu, then SUNA, then Convert Raw Data.
2. Find the "Instrument Package File" that is stored on the PC.
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Convert Raw Data Files to ASCIT x|

-Sensors to Output:

Instrument Package File:

|rs\hva nzee\AppData\Roaming\Sea-Bird-Coastal\UCI 1.0\SUNA_0166_001.xml

W . SUNAD166
=W L SUNAD166
ABS_254
ABS_350
BR_TRACE
CHECK
CTD_DEPTH
CTD_SAL
CTD_TEMP
CTD_TIME
CURRENT
DARK_AVG

nATr

1h91an e
IEE R ENEREX N ]

-

~Raw Data File:

Browse...

- Converted Data File:

Output Directory:

Options
Browse...

IC:\Users\hvanzee\Desktop

OK | Cancel | Help |

4. Select the data file to process in the Raw Data Files area.

If necessary, change the "Output Directory" in the Converted Data Files area.
Push Options to look at the settings to convert files.

5.

Conversion Options

r Conversion Tyoe

Culpul Field Dedimiler: mj

[~ Output Cicra lleader Information

[~ lise satlantic TAra | ngger TIme Stamps

[V Output Frame Time Stamps

[~ Qulpul Framies will Sersor Curves: sion Erors

[ Single Output File per Freme Cefinition

6. Push OK.
The converted file shows in a new tab in the software. It is also saved on the PC in
the directory selected above.

4.1.8.2 Replay logged data
Use Replay Logged Data to look at graphs of the selected data. Data shows in the Time

Series, the Spectra, and the Total Absorbance (if selected) graph tabs.

1.

~Culpul Forrmal

Floaling Poinl Curnve sion Type: IEELiHICﬂ 'l

™ Suppress Nonrnurmeziical Oulpul Velues

Toating Moint Fracision:

I” Henecadma Output Val ias
I” Format Frame Time Stamps

W nisplay convarted nata

Errcr Checking
¥ Frame Counter {if availzkle]

¥ Check Sum (iF availabla)

[+]'¢ | Cancel I lelp

Push Replay Logged Data in the SUNA Dashboard, or go to the Data menu, then
SUNA, then Replay Logged Data.

Make sure that the package file, the data file to replay, and the reference spectra
("calibration") files are selected.
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Replay Logged Data x|

Steps

Replay Logged Data

1. Replay Logged Data

Instrument Package File: |1\R0ammg\Sea-Eird-CoastaI\UCI 1.00SUNA_0166_001.xml Brovise

SUNA Raw Data File: |C:\SUNA\D2E|15U42-ABS_pro.csv Browse

SUNA Calibration File: |C:\SUNA\SNA0166K.CAL Browsse

Status: |AII fields validated, Press Finish to Start Acquisition.

4,

< Back | Ifext = | Finish I Cancel Help

Push Finish.
The saved data shows in the graph tabs.

Push Stop to stop the data.

41.8.3 Reprocess SUNA data
The user may find that it helps to use the Reprocess Data option under some conditions.

The settings for the sensor were incorrect. Use the Reprocess option to correct for
this, such as when a sensor was deployed in seawater, but set up for fresh water.
The data that is collected has changed over an extended deployment. Data is
processed with an updated reference spectrum file, and compared to the original
reference.

Water temperature and salinity data are collected. These can be put together with the
spectral data from the sensor to get more accurate nitrate data (Sakamoto et al.
2009).

Note that the data files collected with SDI-12 do not contain spectral data and cannot be
reprocessed.

1.
2,

Start the software.
Go to the Data menu, then select SUNA, then Reprocess Data.
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Reprocessing Dashboard A |
Nitrate Processing Settings
Instrument Package:

IC:\U sers\hvanzee\AppData\Roaming\Sea-Bird-Coastal\UCI 1.0\SUNA_0166_001.xml Browse |

Calibration File:

|c:\suna\sNAD166K.CAL Browise |

|¥| Processing Settings

Nitrate Data Files

Browse |

C:\SUNA\ADDDOO48.CSV

|¥| Temperature & Salinity Correction

Output Data Files
Output Directory:

[c:\suna Browse |

I” Single Output File ¥ Graph Results

Process Selected File(s)

The Reprocessing Dashboard shows.

3. Push Browse to find the package file, the reference file, and the data file required to
reprocess the data.

4. "Processing Settings" are set by the manufacturer and usually do not need to be
changed.

5. Push Process Selected File(s).
The software starts to reprocess the data.

4.1.8.3.1 Nitrate reprocessing details
Settings in "Processing Settings" and the "Temperature & Salinity Correction" areas do
not show until selected by the user. The user can change these settings as necessary to
get better quality data.

Processing settings
{#! Processing Settings

[ Enable Raw Data Checksum Validation

Fitting Range: |216.5 > |240.0 nm

Max Absorbance Threshold: [1.3

Seawater Calibration
[~ Deployed in Fresh Water

*  The default "Enable Raw Data Checksum Validation" is on, with a check in the box. If
it is turned off, raw data can be processed even when the checksum values have
changed after data is collected.

* The default "Fitting Range" is 216.5-240 nm. If the wavelength is shorter, seawater
typically causes extinction, and a poor signal-to-noise ratio. If the wavelength is
longer non-characterized materials can be absorbed, which causes a bias in the
processed concentrations.

*  The default "Max Absorbance Threshold" is 1.3. The precision of the measured
absorbance starts to decline at this value. At 2.5 absorbance units, the precision is at
the "noise floor." The precision of the processed data is better when the low-quality
parts of the "fitting range" are not processed.

* The default Seawater Calibration has no check in the box at "Deployed in Fresh
Water." Put a check in this box if the sensor was calibrated for seawater but deployed
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in fresh water. Data that was collected in seawater with a check in the "Deployed in
Fresh Water" box gives incorrect nitrate concentrations.

Temperature and salinity correction

%) Temperature & Salinity Correction

¢ CTD Data from SUNA APF Mode Frames

* Data from External File

External File
| Browse |
£ No Data Time Offset +/- (sec): |uuunu

» The default "Activate Temperature & Salinity Correction" has no check in the box. Put
a check in this box to add temperature and salinity correction information.

»  "Temperature and Salinity Correction" is available if the sensor is calibrated for
seawater, and if there is temperature and salinity data available in an ASCII format of
"YYYY-MM-DD hh:mm:ss, Temperature (c), Salinity (PSU)." Push Browse to find the
file to process.

4.2 SDI-12 commands

Note: "Polled" and "Logger-controlled" are both terms for the same mode of operation. The sensor
supports all basic SDI-12 commands. Refer to the SDI-12 specification at www.sdi-12.org for details
of the command protocol. For any command not described below, the sensor will respond
according to the SDI-12 v1.3 specification.

The manufacturer-set address of the SDI-12 is numerical value 48 (ASCII character 0).
The SDI controller uses this address to interface with the sensor in an SDI-12 mode of
operation. The user can change this value in the SDI controller.

Definitions:

+ "a"is the SDI-12 address of the sensor (default is "0")
* <CRC> is the 3-character Cyclic Redundancy Check
* <CR> is a Carriage Return character

* <LF>is aLine Feed character

Acknowledge Active (a!)

Response a<CR><LF>
Purpose verifies the SDI-12 address
Example address =0

SDI recorder sends 0!

sensor sends 0<CR><LF>

Address query (?!)

Response a<CR><LF>
Purpose shows the SDI-12 address
Example address = a

SDI recorder sends ?!

sensor sends a<CR><LF>
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Change address (aAb!)

Response b<CR><LF>
Purpose changes SDI-12 address to "b". The default address is 0.
Example address =0
SDI recorder sends 0A1!
sensor sends 1<CR><LF>
address now = 1
Verify (V!)
Response attn<CR><LF>
Purpose The sensor always responds with a0000<CR><LF> . No diagnostic information is supported.

Send identification (al!) ("a, capital I, !)

Response

allcccccccemmmmmmVVVXXXXXXXXXX<CR><LF>

a = sensor address

Il (lowercase "L") = 2-character SDI-12 version. For example, "13" for version 1.3

ccccecce = 8-character manufacturer identification. For example, "SATLANTC"

mmmmmm = 6-character sensor model. For example, "SUNA"

vvv = 3-character sensor version. For example, "v2"

XXXXXXXXXXXXX = up to 13-character optional field. Format: F<MAJOR>.<MINOR>.<PATCH>
Used for firmware by the manufacturer.

Example

013SATLANTC SUNA v2 0002F2.1.2<CR><LF>

Start Measurement (aM!)
Start Measurement and Request CRC (aMC!)

Start Concurrent Measurement (aC!)
Start Concurrent Measurement and Request CRC (aCC!)

Response atttn<CR><LF>
atttnn<CR><LF>
Purpose starts a measurement.
starts a concurrent measurement.
Notes a = address = (0-9)
ttt = measurement time in seconds. The sensor typically responds in less than 30 seconds.
n or nn. The number of measurement values the sensor makes and returns after subsequent Send
Data commands. Value = 4.
Example 00104<CR><LF> measurement

001004<CR><LF> concurrent measurement

The sensor reports that 10 seconds are required to do the measurement. Typically it will complete
sooner and send a service request to the controller.

In subsequent data commands, the four values are—
nitrate concentration uM

nitrogen in nitrate concentration mgN/L
light spectrum average

dark spectrum average
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Additional Measurement (aM1!)
Additional Measurement and Request CRC (aMC1!)

Additional Concurrent Measurement (aC1!)
Additional Concurrent Measurement and Request CRC (aCC1!)

Response atttn<CR><LF>
atttnn<CR><LF>
Purpose starts a measurement.
starts a concurrent measurement.
Notes a = address = (0-9)
ttt = measurement time in seconds. The sensor typically responds in less than 30 seconds.
n or nn. The number of measurement values the sensor makes and returns after subsequent Send
Data commands. Value = 7.
Example 00067<CR><LF> measurement

000607<CR><LF> concurrent measurement
where 00067 is the address (0), the measurement time (006), and the number of measurements (7).

Example output from

the controller:

oomM1!
0DO!

0D1!

00067 <CR><LF>
0+22.7+22.5+141779+46.8<CR><LF>

0+12.0+5.0+14.0<CR><LF>

Example output from the controller for the seven values—
Example output values in parentheses:

lamp temperature, °C (22.7)
spectrometer temperature, °C (22.5)
lamp time, seconds (141779)
relative humidity, % (46.8)

internal voltage, V (12.0)

regulated voltage, V (5.0)

supplied voltage, V (14.0)

Additional Measurements (aM2!)
Additional Measurements and Request CRC (aMC2!)

Additional Concurrent Measurement (aC2!)
Additional Concurrent Measurement and Request CRC (aCC2!)

Response atttn<CR><LF>
atttnn<CR><LF>
Purpose starts a measurement.
starts a concurrent measurement.
Notes ttt = measurement time in seconds. The sensor typically responds in less than 30 seconds.
n or nn. The number of measurement values the sensor makes and returns after subsequent Send
Data commands. Value = 7.
Example 00099<CR><LF> measurement

000913<CR><LF> concurrent measurement
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Example output from the controller:

oom2!
0DO!

0D1!
oD2!

00099 <CR><LF>
0+3.26+0.0457+15501+721<CR><LF>

0+2015033+20.57608<CR><LF>
0+0.132+0.0672+0<CR><LF>

Example output from the output for the nine (or 13 for concurrent) values—
Example output values in parentheses:

nitrate concentration, uM (3.26)

nitrogen in nitrate concentration, mgN/L (0.0457)

light spectrum average (15501)

dark spectrum average (721)

measurement date (2015033)

measurement time (20.57608)

absorbance at 254 nm (0.132)

absorbance at 350 nm (0.672)

bromide trace (0)

lamp temperature, °C (concurrent measurement only)
spectrometer temperature, °C (concurrent measurement only)
relative humidity, % (concurrent measurement only)

rmse of nitrate processing (concurrent measurement only)

Additional Measurements (aM3-aM9!)
Additional Measurements and Request CRC (aMC3!-aMC9!)

Additional Concurrent Measurement (aC3!-aC9!)
Additional Concurrent Measurement and Request CRC (aCC3!-aCC9!)

Response atttn<CR><LF>
atttnn<CR><LF>
Purpose starts a measurement.
starts a concurrent measurement.
Notes The sensor supports 2 additional measurements.

ttt = 000
n=0
nn =00

"Send Data" commands that come after the aM! or aMC! commands:

Send Data (aD0!-aD9!)

Response a<values><CR><LF>
a<values><CRC><CR><LF>

Purpose sends data to the SDI controller after a measurement or verification command. The response depends
on the previous measurement command.

Note after the M! or C! command the sensor responds with nitrate concentration in two units, and the light
and dark spectrum average.

Example 0+1039.040+14.8434+22799+671<CR><LF>

Note after the MC! or CC! command the sensor responds the same as M! or C! but with a CRC value
attached.

Example 0+1038.188+14.8350+22683+672NtW<CR><LF>

Note after the MC! or CC! command the sensor responds to the aD0! command temperature in two units,

lamp time, and humidity.
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Example 0+33.188+23.500+3356+23.2AsF<CR><LF>
Note The sensor responds to the aD1! command with three voltage units.
Example 0+11.92+5.43+13.68<CR><LF>
after the MC1! command the sensor responds as in the M!! command, but with a CRC value attached.
Example 0+33.813+23.500+3356+23.2AsF<CR><LF>

followed by: 0+11.92+5.43+13.62EyF<CR><LF>

The response to the aC1!, aCC1!, aM2!, aMC2!, aC2!, aCC2! commands is similar.

Continuous Measurement (aR0!-aR9!)
Continuous Measurement and Request CRC (aRC0!-aRC9!)

Response

a<values><CR><LF> or a<values><CRC><CR><LF>

note

the Continuous Measurement command is not supported due to the limited life of the lamp. The sensor
reports a0<CR><LF> or aO<CRC><CR><LF>

4.3 Terminal program

The user can communicate with the sensor through the manufacturer-supplied software,
or by use of a terminal program through the serial port on a PC. Examples of terminal
programs include Putty, Tera Term, and Bray's Terminal.

When power is supplied to the sensor, the sensor goes into a low-power "standby" mode.
Any activity on the input line puts the sensor to the "SUNA>" command interface within
three seconds. The sensor returns to low-power standby after a user-selected period of
time with no communication.

1. Connect the serial cable to the sensor and the PC.
2. Connect the serial cable to an 8-15 VDC, 1 A minimum, power supply.
3. Start a terminal program.
a. Set up the communication values if necessary: 8 bit, no parity, 1 stop bit, no flow
control.

™ COM3:57600baud - Tera Term VT =13
Fle Edit Setup Control Window Help

b. Go to Setup, then Serial Port.
c. If necessary, change the baud rate to 57600. Push OK.

Baud rate: 57600 -
Data: 8 bit h Cancel
Parity: none e

Stop: 1 bit - Lty
Flow control: none -

d

Transmit delay

0 msectchar 0 mseclline
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Turn on the power supply.

Send one or more "$" commands to the sensor to see a prompt at the command line.
The sensor shows "SUNA>" when it is ready to accept commands.

Type "get opermode" to see the current mode of operation for the sensor.

The default value is Fixed Time. It shows as "fixedtime." Refer to Data collection
setup values on page 39 for other values for modes of operation.

Table 4 Status commands

Description Command

Result

Selftest selftest

$Ok—the sensor operates correctly.
I—A sensor component did not operate correctly.

Makes sure the sensor operates correctly, does measurements, and
sends those measurements as the last line of output.

$Error—A sensor component did not pass the test.

Used lamp time get lamptime

The total time the lamp has operated, in seconds.

Wiper test special swipewiper

The wiper operates one time.

Current configuration get config

The sensor shows the current setup configuration.

Get mode of operation get opermode

The sensor shows the current mode of operation.

Set mode of operation set opermode

Changes the mode of operation

7. To change the mode of operation to SDI-12:

a.

SUMA> get opermode

S0k SDIi2
|SUNH>

Make sure that the sensor is so equipped. Type "getopermodesdi12brd"

The response is "available." If the response is "missing”, the sensor is not
equipped with SDI-12.
Type "set opermode sdi12" to change the mode of operation to SDI-12.
ggﬂﬂ) set opermode sdil2

c. Type "get opermode" to make sure that the sensor is in SDI-12 mode.
8. Use the SDI-12 controller to communicate with the sensor when it is in SDI-12 mode.

4.3.1 Input-output configuration values
Parameter Possible values Default value Short name

Baud rate 9600, 19200, 38400, 57600, 115200 57600 baudrate
Message level Error, Warn, Info, Debug Info msglevel
Message file size (MB) 0-65 2 msgfsize

Data file size (MB) 1-65 5 datfsize

Log file type acquisition, continuous, daily acquisition logftype
Acquisition file duration (min) 0-1440 60 afiledur

Data wavelength, low (nm) 210-350 217 wdat_low

Data wavelength, high (nm) 210-350 250 wdat_hgh
4.3.2 Data collection setup values

Parameter Possible values Default value | Short name

Operation mode continuous, fixedtime, periodic, polled, SDI12 fixedtime opermode
Operation control duration, samples samples operctrl
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Countdown (sec) 0-3600 3 countdwn
Fixed time duration (sec) 1-1000000 10 fixddura
Periodic interval 1,2,5,6, 10, 15, 20, 30 (min); 1hr perdival
1,2,3,4,6,8, 12,24 (hr)

Periodic offset (sec) any value 0 perdoffs
Periodic duration (sec) 0-255 10 perddura
Periodic samples (# light frames) 0-255 10 perdsmpl
Polled timeout (sec) 0-65535 10 polltout
Skip sleep at startup on, off off skpsleep
Lamp stability time (ds) ? 0-255 5 stbltime
Lamp switch-off temperature (°C) * (see note below) 35 lamptoff
Spectrometer integration period (msec) | 5-60000 N/A spintper
Dark averages 1-200 1 drkavers
Light averages 1-200 1 Igtavers
Dark samples 1-65535 1 drksmpls
Light samples 1-65535 10 Igtsmpls
Dark duration (sec) 1-65535 10 drkdurat
Light duration (sec) 1-65535 120 Igtdurat
External device none, wiper none exdevtyp
Ext. dev. pre-run time (sec) 1-120 0 exdevper
Ext. dev. during collection on, off off exdevrun
Ext. dev. minimum interval 1-1440 60 exdvival

Periodic Mode of Operation: When power is supplied to the sensor, the sensor goes to a
low-power standby mode. Any activity on the input line puts the sensor to the "SUNA>"
command interface within three seconds. The sensor returns to low-power standby after a
user-selected period of time with no communication.

Continuous Mode of Operation: Data is collected continuously and autonomously when
power is supplied to the sensor. Data collection stops when the user removes power or
enters a "$" character.

Fixed-time Mode of Operation: data collection occurs for the time set up by the user.
When that time is completed, the sensor enters a low-power standby.

Polled Mode of Operation: the sensor is in low power standby mode until there is activity
on the input line. The sensor initializes in 3—4 seconds, then displays a "CMD?" prompt to
show that is it is ready to receive commands from the controller. The "timeout" value
controls the length of time the sensor is in standby mode before it returns to low power
standby mode.

For best accuracy, regular dark measurements are necessary to compensate for the
change in temperature. Select a dark-to-light data collection rate based on either the
number of samples or the duration.

Note:

The lamp turn-off temperature is 35 °C. The lamp should not operate at temperatures above 35 °C.

When the lamp reaches the turn-off temperature, the sensor overrides the user-configured mode of
operation. The sensor does 5 cycles of 5-light to 5-dark sample collection, then does 1-light to 10-
dark cycles until the lamp temperature is below the turn-off temperature.

Contact the manufacturer for information to safely change the turn-off temperature.
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4.3.3 Update firmware

At regular intervals, make sure that the current firmware is installed. Go to the seabird-
coastal.com web site to get the current firmware for the sensor.

1.

@

No ok~

8.
9.

At regular intervals, make sure that the current firmware is installed. Go to the
seabird-coastal.com web site to get the current firmware for the sensor.Save the
firmware to the PC.

The firmware is an ".sfw" file.

Make sure that the sensor is connected to the PC and a power supply.

Start a terminal program such as Putty, HyperTerminal®, or Tera Term.
The steps below use Tera Term as an example.

Adjust the baud rate to 57600.

Turn the power supply on.

Type the "$" command to see the "SUNA>" prompt.

Type the "upgrade" command then push Enter to see the "SATBLDR>" prompt.

|® com3:57600baud - Tera Term VT

Fle Edit Setup Control Window Help

[2015/02-89 19:57:3%2]1 vMainNitratel]
[2015/02-89 19:57:32] vMainNitratel]
[2015-82-89 19:57:41]1 vMainNitrateT]

Satlantic Serial Bootloader
Uersion ]

SATELDR> B

Type "w" then push Enter.
Go to the File menu, then select Transfer > XMODEM Send....

,ﬁ Edit Setup Control Window Help

New connection...  Alt+N
Duplicate session  Alt+D
Cygwin connection Alt+G
LOg...
Catmment i Lod,..
Yiew Lag
Show Log didag,..
Send file...
S5H SCP... Receive...
change dire SR vvoDEm
Replay Log... ZMODEM »

B-Plus 4
TTY Record Quick-VAN »
TTY Replay

10. Select the downloaded firmware in the new window and push Open.

The firmware is sent to the sensor.
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® Tera Term: XMODEM Send e x|

Lookin I B Desktop :J Q2 Er
Name = !VI Size !vl Item type ‘:_J
153 wew wETLabs MRP 2KB Sshortcut

¥ 05 (C) 1 KB Shortcut

@ Product - Shortcut 3KB Shortcut

7 Release (wetime) 2 KB Shortcut

,or] SBC SUNA User Manual 1-21-... 2,286 KB Foxit PhantomPDF PDF

SUNA-LC_Release_2.5.0.sfw

File name: [SUNA-LC_Release_2 5.0 sfw
Files oftype:  |AlI(") =] Cancel
Help

[20815.-82.-8% H inNitrateTask(>:z:INFO-Start
[20815.-82.-8% =47: inNi Task(>: :INFO-Charge]
[2815. 3

x|

Filename:  [SUNA-LC_Release 25

Protocol: XMODEM (checksum)
Packet#: 1
Bytes transfered: 126

Elapsed time: 0:00

| 0.1%

Cancel

When it is complete, the terminal program shows "$Ok Upload successful."

12. Type "v" then push Enter to make sure that the firmware is valid.
The terminal program shows "$0k Application matches stored CRC-32."

B coM3:57600baud - Tera Term VT

Fle Edit Setup Control Window Help

[2015-82-8% 19:57:37] vMainNitrateTask():
[2015-82-8% 17:57:3%] vMainNitrateTask{}:
[2015-82,82 19:57:411 vMainNitrateTask{>:

Satlantic Serial Bootloader
Uerzion 3.2.8

SATELDR> w
50k Upload successful

SATEBLDR> v
S0k Application matches stored CRC-32

13. Type "a" then push Enter. The SATBLDR starts the new firmware in the sensor.

42



Reference

| ‘.';. COM3:57600baud - Tera Term VT

| Fle Edit Setup Control Window Help
[2015,82/89 19:57:411 vMainNitrateTask()::

Satlantic Serial Bootloader
Uersion a

SATBLDR> w
40k Upload successful

SATELDR> v
40k Application matches stored CRC-32

$0k Run Application on startup
SATBLDR> [2815-82-82 28:81:18]1 setup_systen(

14. Turn the power to the sensor off, then back on.
The new firmware operates in the sensor.

15. Go to the File menu, then select Disconnect

4.4 Theory of operation

4.4.1 Background

The SUNA is a chemical-free nitrate sensor for fresh, brackish, and salt water. The
sensor is based on the In-Situ Ultraviolet Spectroscopy (ISUS) that was developed at
MBARI (cf. Kenneth S. Johnson, Luke J. Coletti, Deep-Sea Research 1, 49, 2002,
1291-1305).

The sensor lights the water sample with its deuterium UV light source and measures this
with its spectrometer. The difference between this measurement and a prior baseline
measurement of pure water is the absorption spectrum.

Absorbance characteristics of natural water components are in the calibration file of the
sensor. The Beer-Lambert law for multiple absorbers makes the relationship between the
total measured absorbance and the concentrations of individual components. Based on
this, the sensor gives a best estimate for the nitrate concentration with multi-variable
linear regression.

If the "Integration Time Adjustment" configuration parameter is set to "On" or "Persistent,"
the sensor makes measurements with a spectrometer integration time that is 20 times as
long as the normal integration time. This increases the signal-to-noise ration in faint light
conditions and lets the sensor operate in optically dense conditions. When the optical
density decreases, the sensor goes back to the normal spectrometer integration time.

4.4.2 Description of nutrient units

Nutrient units express the amount of something, usually moles or mass, relative to the
volume it is in. Many researchers and scientists use micromoles per liter (uM), a unit that
is independent of mass and useful for stoichiometric calculations.

Most fresh water monitoring programs and many researchers use units of milligrams per
liter. This unit is almost always expressed as milligrams of relevant atoms per liter—for
example, milligrams of nitrogen (N) per liter, rather than milligrams of nitrate per liter.
Although nitrate NO3 is the most prevalent form of nitrogen, this unit is frequently used as
a means of easily keeping track of total nitrogen loading. Because milligrams per liter is a
mass-based unit and the mass of N and NOj are different, this difference is very
important to prevent mistakes. Milligrams per liter is also typically referred to as parts per
million (ppm), the mass of N relative to the mass of water.

The SUNA V2 sensor measures dissolved nitrate and displays units in micromolar (uM)
or milligrams of nitrogen per liter (mg/N/L). The SUNA V2 does not display milligrams of
nitrate per liter (mg/L or mgNOs/L ).

43



Reference

4.4.3 Nitrate concentration

Nitrate processing uses the 217-240 nm wavelength range, which contains
approximately 35 spectrometer channels. The precision of the nitrate concentration is
related to the number of absorbers into which the measured absorbance is decomposed.
High absorbance conditions introduce inaccuracies into the nitrate concentrations.
Channels with an absorbance of more than 1.3 are not included in the processing. If less
than approximately 10 channels remain, the sensor cannot give a nitrate concentration.
The user can increase the absorbance cutoff and get decreased-accuracy nitrate
concentration at higher absorbances.

4.4.4 Description of adaptive sampling

The SUNA V2 has a 256-channel spectrometer that integrates for a specific length of
time, usually 300-500 ms, to maximize the signal while it collects data. When the sensor
does a measurement, the spectrograph collects UV light for the length of the integration
period. In optically dense waters, with high turbidity or CDOM, very little UV light is
transmitted through the water, so the spectrometer "sees" a much lower signal. The
SUNA V2 automatically increases the integration period to compensate for the low light,
so the sensor collects a strong signal in extreme environmental conditions.

4.4.5 Sensor calibration from manufacturer

Sensors come from the manufacturer with a default class-based calibration. Sensors can
have an optional sensor-specific calibration for either fresh water or seawater. The user
can configure a seawater calibration to be deployed in either fresh water or seawater.

The calibration file is stored in the sensor and includes the coefficients to calculate nitrate,
as well as a reference spectrum. It is necessary for the user to update the reference
spectrum as the optical components change over time. The software has a wizard to let
the user update the reference spectrum at regular intervals or as necessary. This
procedure adjusts the "zero" nitrate value based on a sample of pure water (ultra pure,
nano pure, or DI). It is necessary to periodically update the reference spectrum to make
sure that the sensor collects accurate data.

For best performance, send the sensor back to the manufacturer annually for
maintenance.

4.5 Interferences and mitigation

4.5.1 Uncharacterized species in sample

A number of substances in natural water absorb in the UV spectral range where nitrate
absorbs. The spectral signature is usually different from nitrate but certain combinations
of water components may cause a bias in the calculated nitrate concentrations.

If the user thinks there are significant concentrations of interfering species, do a random
spectral and chemical analysis of the water sample to quantify and correct the optical
interference.

4.5.2 Optically dense constituents

The performance of the sensor is compromised in optically dense conditions, which
transmit less light than necessary for the regression analysis. As the optical density
increases, the quality of the measurement (signal-to-noise) decreases. The accuracy and
precision of the nitrate concentration measurements decrease as the quality of the data
decreases. High optical densities are frequently caused by CDOM or turbidity in the water
sample.

4.5.3 Sample temperature

Seawater has a temperature-dependent absorption rate. Make sure to consider this so
that imprecision does not affect the nitrate concentration that is measured. To mitigate
this effect, use the sample temperature and salinity values in the nitrate calculation in the
host software for post-processing. Note that spectra and related temperature and salinity
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data is necessary. The temperature-salinity correction comes from MBARI (cf. Carole M.
Sakamoto, Kenneth S. Johnson, and Luke Coletti, Limnol. Oceanogr.: Methods 7, 2009.)

4.5.4 I|dentification of interfering species

The effect of turbidity and CDOM on the measured nitrate concentration was calculated in

the laboratory.

Turbidity sample NTU per Absorbance at NO; change, uM, in NO; change, pM, in
mg/L 225 nm (10 mm) freshwater per mg/L seawater per mg/L
per mg/L
Arizona Road Dust (ARD) 1.25 0.0016 <-0.002 (-2.8 e -5) 0.01 (1.4 e-4)
Kaolin powder 1.5 0.0085 <0.001 (1.4 e-5) 0.02 (-2.8 e -4)
Titanium dioxide (TiO,) 15.0 0.0090 <0.001 (1.4 e-5) <0.001 (1.4 e-5)
CDOM sample QSD per mg/L Absorbance at NO; change, pM, in NO; change, pM, in
particle 225 nm (10 mm) per seawater per mg/L seawater per mg/L
mg/L particle particle particle
Pony Lake Fulvic Acid N/A 0.017 0.4 (5.6 e-3) 0.6 (8.4 e-3)
reference (1R109F)
Suwannee River Fulvic Acid N/A 0.027 <01(1.4 e-3) <01(1.4 e-3)
standard (1S101F)
Pahokee Peat Humic Acid 42 0.003 <0.01 (1.4 e-4) <0.1(1.4 e-3)
reference (1R103H-2)

An interfering species causes an incorrect nitrate concentration when its spectral
characteristics are almost the same as nitrate. The RMSE value is the square root of the
mean of the sum of the squared differences between the measured and the fitted
absorbance. The RMSE is a measure of the quality of the fit. Independent measurements
of turbidity and CDOM, and an analysis of the absorption spectrum help the impact
analysis.

4.5.5 Sensor function

The lamp and other optical components in the sensor change with time. This causes
nitrate measurements to change, or "drift." Do regular updates to the reference, or

baseline, spectrum to minimize this change.
The output of the lamp is related to it temperature. The manufacturer recommends that

the user collect the reference (baseline) spectrum in conditions that are almost the same
as a deployment.
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4.6 CDOM absorption

Figure 4 Fulvic acid, mg/l. Note that the CDOM spectral shape overlaps with the nitrate processing

region.
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The model to calculate nitrate fits for 4 parameters: nitrate, bromide, a temperature
coefficient and a linear baseline correction that accounts for all additional absorbing
species. If the absorption of the sample is high (default cut-off = 1.3 AU), the model can
no longer be used effectively to fit parameters or calculate nitrate concentration. The
SUNA V2 data output is a root mean square error parameter that indicates the quality of
the fit of the models to the absorption curves.

CDOM Absorption Properties

Colored Dissolved Organic Matter (CDOM) is one of the main substance classes that
absorbs in the same UV range as nitrate. (Other significant absorbers are seawater,
bromide, bisulfite, and suspended particles). CDOM is a mixture of many chemicals, and
changes across locations and times, usually depending on its origin. Thus, there is no
universal characterization of the UV absorption of CDOM.

CDOM Impact on SUNA Nitrate Concentration

The UV absorption spectra of CDOM changes across the types of CDOM. Some types of
CDOM are closer in their absorption to nitrate than others. Types of CDOM that absorb
similar to nitrate will cause a larger bias than those that absorb dissimilar. Thus, the
concentration of CDOM alone cannot predict the magnitude of the bias.

Quantification and Correction of CDOM Impact

Under ideal conditions, CDOM would be isolated from all other absorbers, and its
absorbing properties identified in isolation. A more realistic approach is to independently
find the content (nitrate, salinity, CDOM) of a number of water samples (if CDOM is stable
over time), and calculate the CDOM-induced bias on the nitrate concentration.

FDOM: Fluorescent Dissolved Organic Matter is a subset of Colored DOM and can be
used as a proxy for CDOM (if the composition is stable over time). Most FDOM sensors
use a 370 nm excitation source that targets more humic substances, and may not
represent absorption in the nitrate range (~220 nm).

Absorption: The data output of the SUNA V2 is the absorption at 350 nm and 254 nm
(A350 and A254). These wavelengths are outside the nitrate absorption range and can be
used to make an estimate of the impact of CDOM. If absorption is high (>1.3 AU), the
SUNA will not be able to collect adequate light to make a measurement.
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RMSE: The root mean square error parameter from the SUNA V2 can be used to make
an estimate of how well the nitrate spectral fit is. This should usually be less than 1E-3. If
it is higher there is spectral shape (likely due to CDOM) that adversely impacts the nitrate
estimate.

Pathlength: SUNA V2 comes in both a 10 mm and a 5 mm pathlength version. Because
absorbance is directly proportional to pathlength, a halved pathlength provides a
tolerance of approximately twice the background absorption.

4.7 Optional equipment

4.71 Wiper

The wiper cleans the optical window of biological growth and particulates so that the
quality of the data collected stays constant. The wiper works in all modes of operation of
the sensor. The wiper operates one time before each time that data is collected.

The wiper operates at 90 degrees. Make sure the wiper can operate without any
blockage. Each cycle of the wiper across the optical window takes approximately
15 seconds. There is a minimum required delay of 30 seconds between wiper cycles.

Figure 5 SUNA with wiper

&

The wiper drive shaft has a mechanism that lets the wiper be moved manually without
damage. Make sure that the wiper is not bent or pushed off of its axis of rotation.

4.7.2 Anti-fouling guard

Use the anti-fouling guard for moored deployments that do not use a pump. The guard is
attached to the sensor by a plastic clamp. The foul guard is made of perforated copper
that goes around the sample volume to prevent biofouling and lets the sample volume
flush. Operate the sensor horizontally and point the sample volume area downward so
that air bubbles and sediment do not collect.

Figure 6 Copper anti-fouling guard
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4.7.3 Flow cell

Use the flow cell for moored deployments that require a pump. Attach the flow cell to the
sensor with the manufacturer-supplied plastic clamp. The flow cell seals against the
pressure housing of the sensor so that the water from the pump flows across the optical
path of the sensor. The flow cell has a copper tube on the inlet port and a plastic barbed
fitting on the outlet port that connects to the pump with flexible tubing. Spare parts for the
flow cell include elbow fittings so that the user can adjust the position of the sensor for
deployment.

Figure 7 SUNA flow cell
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Section 5 Troubleshooting

5.1 SUNA general troubleshooting

AWARNING

Nitrate sensors use an ultraviolet (UV) light. Do not look directly at a UV light when it is on. It can damage the eyes. Keep
products that have UV light away from children, pets, and other living organisms. Wear polycarbonate UV-resistant safety

glasses to protect the eyes when a UV light is on.

Possible problem

Possible solution

Sensor does not appear to be on

Check that the cable is connected and the power source is on.

Turn the sensor off for at least 60 seconds. Turn the power on again. If the sensor still
does not appear to be on, use a different cable.

Check that the voltage supplied to the sensor is between 8—15 VDC with at least 1 amp of
current. Check the cable voltage: put the leads of a DMM in DC voltage mode at contacts
1 (+) and 2 (-) of the cable to see if there is voltage. If not, use a different cable.

Check the mode of operation. The sensor may be in an unknown mode. Start a terminal
program, supply power to the sensor, and type "$" then "Enter" three or more times. A
prompt from the sensor shows.

Check the cable for continuity. Refer to the sensor specifications for connector functions.

Check the power consumption. Use a power supply with an accurate digital current
indicator.

« current > 500 mA at 12V: sensor is in data collection mode. Put a piece of white
paper into the optical area and make sure that there is a blue spot. If there is not, the
sensor may be in an unknown mode or there is a system failure.

* current > 5 mA: sensor is in "standby" mode and gives a result over the RS232 input.
* current >100 pA: sensor is not in operation. Contact Customer Support.

5.2 SUNA operation troubleshooting

Possible problem

Possible solution

Self-test fails for internal
humidity

Monitor the sensor and do a sensor self-test at regular intervals. Make sure that the
sensor is not attached to any frame so tightly that the pressure housing is out-of-round.

Self-test fails for low spectrum
average or high dark counts

Clean the optical windows with a low-lint swab or tissue and isopropyl alcohol.
The average value in DI water is within specifications shown below.

. Dark spectrum: 500—1000 counts, with a standard deviation of no more than
12 counts.

. Maximum light spectrum: no more than 55000, with no more than 60-count standard
deviation.

*  Average light spectrum: approximately 10000-15000 counts, with ranges to at least
20000 counts. An average value of <10000 may mean that the optical windows are
dirty or stained, or that the lamp is degraded.

Baseline "drift"

Check if the lamp is degraded. Apply drift corrections if the rate is approximately
0.004 mgN/L per hour of lamp "on" time.

Wiper does not operate correctly

Make sure that there is a check in the box for "Integrated Wiper Enabled" in the
General tab of the Settings tab of the software.

»  Check the alignment of the wiper brushes and make sure that the wiper is not bent

+ If the wiper is from another manufacturer, check that the battery contacts are
functional.
»  Contact Customer Support for further help.
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5.3 SUNA communication troubleshooting

Possible problem

Possible solution

Collected data is different from
transmitted data

Check the clock settings in the sensor.
Make sure that there is no extra averaging or data collection in the setup.
Check the data output settings.

Problems with sensor-to-
software communication

Make sure that the sensor-PC cable is connected correctly.
Make sure the current software and firmware are installed.

Self-test fails to complete

Make sure that the sensor has an external power source; external power is necessary to
turn on the lamp.

5.4 SUNA warnings and error messages

Possible problem

Possible solution

Data warnings and error
messages

Contact Customer Support. If possible, have the information listed below:

screenshot of the "Application Console" of the software.

"messages.log" file—go to the Transfer Files window and select the Log Files tab.
Copy the file to the PC for Customer Support.

Negative nitrate concentration

Clean the optical area and check the reference spectrum. Apply a new one if necessary.

Make sure that the sensor is in water.
Check that the "Deploy in Fresh Water" box has the appropriate check in it.
Check for salinity compensation.

Analysis of nitrate standard shows
sensor is possibly out of
specification

Check that the nitrate standard concentrations are accurate. Make sure the dilutions
were done correctly and that the standards are used within 1 week (in the lab) or before
expiration (unopened standards). Verify that the standards were made in comparable
units (mg/L as nitrogen or uMoles).

Check the sensor settings. Make sure that the "Deployed in Fresh Water" setting has a
check in the box if the sensor operates in fresh water.

Poor correlation with field samples
(grab samples)

Check the sensor for fouling or lamp change ("drift"). Clean the optical windows and do a
blank check.

Set the sensor to do a self-test. Check light:dark counts, such as high CDOM or
other absorbers and other data about the sensor.

Check for matrix interferences that can cause measurement errors. Do
measurements for a wider range of constituents an do possible lab matrix spikes to
isolate the cause.

Check the representativeness of the data collection site. If the data from the sensor does
not agree with grab samples but shows good performance, the site may not be
representative of conditions, or the water is not well mixed.

Data collection rate is very slow

Check if the internal memory is on. Data collection starts after approximately 5 seconds.

Check if the "adaptive integration” is on. Data collection starts after approximately
500 milliseconds (20 x "integration period").

Nitrate values are not stable

Check that the optical area is not blocked with debris.
Check that the wiper functions correctly.
Clean and dry the optical area.
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Possible problem Possible solution

Nitrate value are frequently "-1" or | Check that the lamp intensity is sufficient. Measure the spectrum in DI or tap water.
"NAN" Maximum output is > 10000. For best case, > 30000.

Check the data: if the maximum is < 1000 and the lamp intensity is sufficient, the water
sample is optically dense.

SELFTEST alert for lamp intensity | Check the sensor for high internal humidity. Do a "selftest":
or high humidity if humidity is > 50%, the sensor may have a leak. Contact Customer Support.

if humdity is > 30%, the sensor is probably ok. Contact Customer Support.
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Section 6

General information

6.1 Warranty

Revised editions of this user manual are on the manufacturer's website.

This sensor is warranted against defects in materials and workmanship for one year from
the date of purchase. The warranty is void if the manufacturer finds the sensor was
abused or neglected beyond the normal wear and tear of deployment.

6.2 Service and support

The manufacturer recommends that sensors be sent back to the factory annually to be
cleaned, calibrated, and for standard maintenance.

Refer to the website for FAQs and technical notes, or contact the manufacturer for
support at:

support@sea-birdcoastal.com
Do the steps below to send a sensor back to the manufacturer.

1.

2,

Contact the manufacturer for a Return Merchandise Authorization (RMA).

Note: The manufacturer is not responsible for damage to the sensor during return shipment.
Remove all anti-fouling treatment from the sensor before sending it back to the
manufacturer.

Note: The manufacturer will not accept sensors that have been treated with anti-fouling
compounds for service or repair. This includes tri-butyl tin, marine anti-fouling paint, ablative
coatings, etc.

Use the sensor's original ruggedized shipping case to send the sensor back to the
manufacturer.

Write the RMA number on the outside of the shipping case and on the packing list.
Use 3rd-day air to ship the sensor back to the manufacturer. Do not use ground
shipping.

The manufacturer will supply all replacement parts and labor and pay to send the
sensor back to the user via 3rd-day air shipping.

6.3 Waste electrical and electronic equipment

Electrical equipment that is marked with this symbol may not be disposed of in European public

disposal systems. In conformity with EU Directive 2002/96/EC, European electrical equipment
users must return old or end-of-life equipment to the manufacturer for disposal at no charge to
the user. To recycle, please contact the manufacturer for instructions on how to return end-of-
life equipment, manufacturer-supplied electrical accessories, and auxiliary items for proper
disposal.
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